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The MSP-EXP430FR2355 LaunchPad™ Development Kit is an easy-to-use Evaluation Module (EVM) for
the MSP430FR2355 microcontroller (MCU). The kit contains everything needed to start developing on the
ultra-low-power MSP430FRx FRAM microcontroller platform, including onboard debug probe for
programming, debugging, and energy measurements. The board also features onboard buttons and LEDs
for quick integration of a simple user interface, an onboard Grove connector for external Grove sensors,
as well as an ambient light sensor to showcase the integrated analog peripherals.

Figure 1 shows the MSP-EXP430FR2355 LaunchPad development kit.

Figure 1. MSP-EXP430FR2355 LaunchPad Development Kit
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1 Getting Started

1.1 Introduction
The 24-MHz MSP430FR2355 device features 32KB of embedded FRAM (ferroelectric random access
memory), a nonvolatile memory known for its ultra-low power, high endurance, and high speed write
access. Combined with 4KB of on-chip RAM, users have access to 32KB of memory to split between their
program and data as required. For example, a data logging application may require a large data memory
with relatively small program memory, so the memory may be allocated as required between program and
data memory.

Rapid prototyping is simplified by the 40-pin BoosterPack™ plug-in module headers, which support a wide
range of available BoosterPack plug-in modules. You can quickly add features like wireless connectivity,
graphical displays, environmental sensing, and much more. Design your own BoosterPack plug-in module
or choose among many already available from TI and third-party developers.

Free software development tools are also available, such as TI’s Eclipse-based Code Composer Studio™
IDE (CCS) and IAR Embedded Workbench® IDE. Both of these IDEs support EnergyTrace™ technology
for real-time power profiling and debugging when paired with the MSP430FR2355 LaunchPad
development kit.

1.2 Key Features
• MSP ULP FRAM technology based MSP430FR2355 16-bit MCU
• EnergyTrace technology available for ultra-low-power debugging
• 40-pin LaunchPad development kit standard leveraging the BoosterPack plug-in module ecosystem
• Onboard eZ-FET debug probe
• 2 buttons and 2 LEDs for user interaction
• Ambient light sensor for the Out-of-Box Experience demo
• Grove connector for external Grove sensors

1.3 What’s Included

1.3.1 Kit Contents
• 1 MSP-EXP430FR2355 LaunchPad Development Kit
• 1 Micro USB cable
• 1 Quick Start Guide

1.3.2 Software Examples
• Out-of-Box Software

1.4 First Steps: Out-of-Box Experience
An easy way to get started with the EVM is by using its preprogrammed out-of-box code. It demonstrates
some key features of the EVM.

1.4.1 Connecting to the Computer
Connect the LaunchPad development kit using the included USB cable to a computer. A green power LED
should illuminate. For proper operation, drivers are needed. TI recommends that you get the drivers by
installing an IDE such as TI's CCS or IAR EW430. Drivers are also available at www.ti.com/MSPdrivers.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/tool/CCSTUDIO-MSP430
http://www.ti.com/tool/CCSTUDIO-MSP430
http://www.ti.com/tool/iar-kickstart
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http://www.ti.com/MSPdrivers
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1.4.2 Running the Out-of-Box Experience
The Out-of-Box Experience (OOBE) of the MSP-EXP430FR2355 LaunchPad development kit
demonstrates how to set up multiple integrated Smart Analog Combo (SAC) peripherals of the
MSP430FR2355 MCU and how to use the interconnections between SAC pairs in various demo
scenarios. The OOBE includes two modes, a Light Sensor mode and a Function Generator mode. In the
Function Generator mode, the LaunchPad development kit transmits digital data to the PC and can be
visualized using the accompanying cloud GUI (visit MSP-EXP430FR2355 OOB GUI).

By default after power up, the MSP-EXP430FR2355 LaunchPad development kit enters the Light Sensor
mode, in which LED1 or LED2 brightens or dims based on the amount of ambient light sensed by the
photodiode, D1. A default brightness threshold is set at approximately half of the full brightness detection
range of D1 at which both LED1 and LED2 are off. Shine a light source such as a flashlight or cover up
D1 using your hand, and notice the green LED2 gets brighter as more light reaches D1, while the red
LED1 gets brighter as less light reaches D1. Press button S1 in the Light Sensor mode to set the new
brightness threshold at the current ambient light level.

Next, try pressing S2 to enter Function Generator mode. By default, the LaunchPad development kit starts
to generate a 1-Hz inverted sine wave at 0.8-V amplitude on pin P1.5. This signal is a result of using one
of the SAC 12-bit DACs to generate a sine wave and feeding it into a second SAC, which is configured as
an inverting programmable gain amplifier (PGA). The resulting waveform on pin P1.5 is also captured by
the MSP430FR2355 internal ADC, and the live data are transmitted to the PC. An accompanying cloud
GUI (visit MSP-EXP430FR2355 OOB GUI) is available to visualize the ADC measurements of the
generated waveform. This GUI also provides various controls for changing the signal type (sinusoidal,
square, or sawtooth), frequency, and amplitude of the DAC waveform generation and for configuring the
PGA mode (inverting or noninverting) and gain. See Section 3.1 for more details on the OOBE and how to
use its accompanying cloud GUI.

This GUI is created with GUI Composer 2.0 with the source available for customization, imported from the
TI Cloud Gallery. The serial communication port on the PC must be configured with 115200 bps, one stop
bit, and no flow control.

NOTE: The OOB cloud GUI is only supported in the latest versions of Chrome, Firefox, and Safari
browsers. An installer for the offline standalone GUI can also be downloaded from the TI
Cloud Gallery.

1.5 Next Steps: Looking Into the Provided Code
After the EVM features have been explored, the fun can begin. It’s time to open an integrated
development environment and start editing the code examples. See Section 4 for available IDEs and
where to download them.

The quickest way to get started using the LaunchPad development kit is to use TI’s Cloud Development
Tools. The cloud-based Resource Explorer provides access to all of the examples and resources in
MSPWare. Code Composer Studio Cloud is a simple Cloud-based IDE that enables developing and
running applications on the LaunchPad development kit.

The out-of-box source code and more code examples are provided and available on the download page.
Code is licensed under BSD, and TI encourages reuse and modifications to fit specific needs.

Section 3 describes all functions in detail and provides a project structure to help familiarize you with the
code.

With the onboard eZ-FET debug probe, debugging and downloading new code is simple. A USB
connection between the EVM and a PC through the provided USB cable is all that is needed.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
https://dev.ti.com/gallery/view/3491167/MSP-EXP430FR2355_OOB_GUI/
https://dev.ti.com/gallery/view/3491167/MSP-EXP430FR2355_OOB_GUI/
https://dev.ti.com/gc/
https://dev.ti.com/gallery/
https://dev.ti.com/gallery/
https://dev.ti.com/gallery/
http://dev.ti.com/
http://dev.ti.com/
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR2355/latest/index_FDS.html


Target device

MSP430FR2355

Crystal

32.768 kHz

Micro-B

USB

3.3-V LDO

ESD

Protection

Debug

MCU

LED

Red, Green
Crystal

4 MHz

UART, SBW to Target

User interface

2 buttons, 2 LEDs

40-pin

LaunchPad

standard headers

Power to Target

Reset

button

EnergyTrace

Technology

Grove

Connector
Ambient Light

Sensor

Hardware www.ti.com

6 SLAU680–May 2018
Submit Documentation Feedback

Copyright © 2018, Texas Instruments Incorporated

MSP430FR2355 LaunchPad™ Development Kit (MSP‑EXP430FR2355)

2 Hardware
Figure 2 shows an overview of the MSP-EXP430FR2355 hardware.

Figure 2. MSP-EXP430FR2355 Overview

2.1 Block Diagram
Figure 3 shows the block diagram.

Figure 3. MSP-EXP430FR2355 Block Diagram
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http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680


www.ti.com Hardware

7SLAU680–May 2018
Submit Documentation Feedback

Copyright © 2018, Texas Instruments Incorporated

MSP430FR2355 LaunchPad™ Development Kit (MSP‑EXP430FR2355)

2.2 Hardware Features

2.2.1 MSP430FR2355 MCU
The MSP430FR2355 is an ultra-low-power MSP430FRx FRAM-based microcontroller (MCU), which offer
extended data logging and security capabilities. The MSP430FR2355 offers the small LQFP package (7
mm × 7 mm) in the FRAM microcontroller portfolio, combined with a variety of integrated peripherals and
ultra-low power consumption. FRAM is a cutting edge memory technology, combining the best features of
flash and RAM into one nonvolatile memory. More information on FRAM can be found at www.ti.com/fram.

Device features include:
• 1.8-V to 3.6-V operation
• 16-Bit RISC architecture up to 24-MHz system clock and 8-MHz FRAM access
• 32KB of Program FRAM, 512 bytes of Information FRAM, and 4KB of RAM
• 12-channel 12-bit ADC
• Two enhanced comparator with integrated 6-bit DAC as reference voltage
• Four Smart Analog Combo (SAC-L3)
• Three 16-bit timers with three capture/compare registers (Timer_B3)
• One 16-bit timer with seven capture/compare registers (Timer_B7)
• 32-bit hardware multiplier (MPY)
• 44 GPIOs

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/fram
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Figure 4. MSP430FR2355 Pinout
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2.2.2 eZ-FET Onboard Debug Probe With EnergyTrace™ Technology
To keep development easy and cost effective, TI’s LaunchPad development kits integrate an onboard
debug probe, which eliminates the need for expensive programmers. The MSP-EXP430FR2355 has the
eZ-FET debug probe (see Figure 5), which is a simple and low-cost debugger that supports all MSP430™
device derivatives.

Figure 5. eZ-FET Debug Probe

The MSP-EXP430FR2355 LaunchPad development kit features EnergyTrace technology but does not
have support for EnergyTrace++ technology. The EnergyTrace technology functionality varies across the
MSP portfolio.

Table 1. EnergyTrace Technology

Features EnergyTrace Technology EnergyTrace++ Technology
Current Monitoring ✔ ✔
CPU State ✔
Peripheral and System State ✔

Devices Supported All MSP430 MCUs MSP430FR59xx and MSP430FR69xx
MCUs

Development Tool Required MSP-FET or eZ-FET MSP-FET or eZ-FET

The dotted line through J101 shown in Figure 5 divides the eZ-FET debug probe from the target area. The
signals that cross this line can be disconnected by jumpers on J101, the isolation jumper block. More
details on the isolation jumper block are in Section 2.2.3.

The eZ-FET also provides a "backchannel" UART-over-USB connection with the host, which can be very
useful during debugging and for easy communication with a PC. More details can be found in
Section 2.2.4.

The eZ-FET hardware can be found in the schematics in Section 6 and in the hardware design files
download page. The software and more information about the debugger can be found on the eZ-FET wiki.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/lit/zip/slar152
http://www.ti.com/lit/zip/slar152
http://processors.wiki.ti.com/index.php/EZ-FET_lite
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2.2.3 Debug Probe Connection: Isolation Jumper Block
The isolation jumper block at jumper J101 allows the user to connect or disconnect signals that cross from
the eZ-FET domain into the MSP430FR2355 target domain. This includes eZ-FET Spy-Bi-Wire signals,
application UART signals, and 3.3-V and 5-V power.

Reasons to open these connections:
• To remove any and all influence from the eZ-FET debug probe for high accuracy target power

measurements
• To control 3-V and 5-V power flow between the eZ-FET and target domains
• To expose the target MCU pins for other use than onboard debugging and application UART

communication
• To expose the programming and UART interface of the eZ-FET so that it can be used for devices other

than the onboard MCU.

Table 2. Isolation Block Connections

Jumper Description
GND Ground
5V 5-V VBUS from USB

3V3 3.3-V rail, derived from VBUS in the eZ-FET domain

RXD << Backchannel UART: The target FR2355 receives data through this signal. The arrows indicate the direction of the
signal.

TXD >> Backchannel UART: The target FR2355 sends data through this signal. The arrows indicate the direction of the
signal.

SBW RST Spy-Bi-Wire debug: SBWTDIO data signal. This pin also functions as the RST signal (active low).
SBW TST Spy-Bi-Wire debug: SBWTCK clock signal. This pin also functions as the TST signal.

Figure 6. eZ-FET Isolation Jumper Block Diagram

http://www.ti.com
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2.2.4 Application (or "Backchannel") UART
The backchannel UART allows communication with the USB host that is not part of the target application’s
main functionality. This is very useful during development, and also provides a communication channel to
the PC host side. This can be used to create graphical user interfaces (GUIs) and other programs on the
PC that communicate with the LaunchPad development kit.

Figure 6 shows the pathway of the backchannel UART. The backchannel UART is the UART on
eUSCI_A1.

On the host side, a virtual COM port for the application backchannel UART is generated when the
LaunchPad development kit enumerates on the host. You can use any PC application that interfaces with
COM ports, including terminal applications like Hyperterminal or Docklight, to open this port and
communicate with the target application. You need to identify the COM port for the backchannel. On
Windows PCs, Device Manager can assist.

Figure 7. Application Backchannel UART in Device Manager

The backchannel UART is the "MSP Application UART1" port. In this case, Figure 7 shows COM13, but
this port can vary from one host PC to the next. After you identify the correct COM port, configure it in
your host application according to its documentation. You can then open the port and begin
communication to it from the host.

On the target MSP430FR2355 side, the backchannel is connected to the eUSCI_A1 module. The eZ-FET
has a configurable baud rate; therefore, it is important that the PC application configures the baud rate to
be the same as what is configured on the eUSCI_A1.

2.2.5 Special Features

2.2.5.1 Smart Analog Combo (SAC)
The MSP430FR2355 MCU LaunchPad development kit features pins to access the SAC on the device.
These pins are accessed on jumpers J7, J8 and J9 where the SAC operational amplifier is connected to
the onboard photodiode circuit. These pins are also connected to the BoosterPack plug-in module header
pins. For applications that use the SAC and a connected BoosterPack plug-in module, be sure to check
for any pin conflicts. The photodiode circuit can be disconnected from the SAC using jumpers J7, J8 and
J9. The user can connect an external analog sensor circuit to the SAC by removing jumpers J7, J8 and J9
and connecting their circuit to the appropriate header pins through the BoosterPack plug-in module
headers or the jumpers near the light sensor circuit. To adjust the sensitivity of the light sensor circuit, the
user can adjust either the software or the hardware. By changing the values of R3 and C6, the user can
change the operational amplifier low-pass filter and sensitivity to the current of the photodiode. The user
can also adjust the calculations performed in the software to adjust the sensitivity of the circuit to their
desired level.

2.2.5.2 Grove Connector
The MSP430FR2355 MCU LaunchPad development kit features an onboard Grove connector for Analog
and Digital Grove modules from Seeed Studio. The Grove connector consists of 4 pins that are routed to
3.3 V, GND, P1.1, and P1.4. Users can take advantage of this connector and begin prototyping with
different Grove sensors and actuators without the need to interface the LaunchPad development kit with a
Grove Base BoosterPack plug-in module.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
https://www.seeedstudio.com/
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2.3 Power
The board accommodates various powering methods, including through the onboard eZ-FET as well as
external or BoosterPack plug-in module power (see Figure 8).

Figure 8. MSP-EXP430FR2355 Power Block Diagram

2.3.1 eZ-FET USB Power
The most common power-supply scenario is from USB through the eZ-FET debugger. This provides 5-V
power from the USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the
target side of the LaunchPad development kit. Power from the eZ-FET is controlled by jumper J101. For
3.3 V, make sure that a jumper is connected across the J101 3V3 terminal.

2.3.2 BoosterPack Plug-in Module and External Power Supply
Header J5 is present on the board to supply external power directly. It is important to comply with the
device voltage operation specifications when supplying external power. The MSP430FR2355 has an
operating range of 1.8 V to 3.6 V. More information can be found in the MSP430FR2355 Mixed-Signal
Microcontroller data sheet.

2.4 Measure Current Draw of the MSP430 MCU
To measure the current draw of the MSP430FR2355 MCU using a multimeter, use the 3V3 jumper on the
J101 jumper isolation block. The current measured includes the target device and any current drawn
through the BoosterPack plug-in module headers.

To measure ultra-low power, follow these steps:
• Remove the 3V3 jumper in the J101 isolation block, and attach an ammeter across this jumper.
• Consider the effect that the backchannel UART and any circuitry attached to the MSP430FR2355 may

have on current draw. Consider disconnecting these at the isolation jumper block, or at least consider
their current sinking and sourcing capability in the final measurement.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/lit/pdf/SLASEC4
http://www.ti.com/lit/pdf/SLASEC4
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• Make sure there are no floating inputs/outputs (I/Os) on the MSP430FR2355. These cause
unnecessary extra current draw. Every I/O should either be driven out or, if it is an input, should be
pulled or driven to a high or low level.

• Begin target execution.
• Measure the current. Keep in mind that if the current levels are fluctuating, it may be difficult to get a

stable measurement. It is easier to measure quiescent states.

EnergyTrace technology can also be used to compare various current profiles and better optimize your
energy performance!

2.5 Clocking
The MSP-EXP430FR2355 provides an external clock in addition to the internal clocks in the device.
• Q1: 32.768-kHz 12.5-pF crystal

The 32.768-kHz crystal allows for lower LPM sleep currents than do the other low-frequency clock
sources. Therefore, the presence of the crystal allows the full range of low-power modes to be used.

The internal clocks in the device default to the following configuration:
• MCLK: DCO at 1 MHz
• SMCLK: DCO at 1 MHz
• ACLK: REFO at 32.768 kHz

For more information about configuring internal clocks and using the external oscillators, see the
MSP430FR4xx and MSP430FR2xx Family User's Guide.

2.6 Using the eZ-FET Debug Probe with a Different Target
The eZ-FET debug probe on the LaunchPad development kit can interface to most MSP430 derivative
devices, not just the onboard MSP430FR2355 target device.

To do this, disconnect every jumper in the isolation jumper block. This is necessary, because the debug
probe cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.

Next, make sure the target board has proper connections for SBW. Note that to be compatible with SBW,
the capacitor on RST/SBWTDIO cannot be greater than 2.2 nF. The documentation for designing MSP430
JTAG interface circuitry is the MSP430 Hardware Tools User's Guide.

Finally, wire together these signals from the debug probe side of the isolation jumper block to the target
hardware:
• 5 V (if 5 V is needed)
• 3.3 V
• GND
• SBWTDIO
• SBWTCK
• TXD (if the UART backchannel is to be used)
• RXD (if the UART backchannel is to be used)

This wiring can be done either with jumper wires or by designing the board with a connector that plugs into
the isolation jumper block.

2.7 BoosterPack Plug-in Module Pinout
The LaunchPad development kit adheres to the 40-pin LaunchPad development kit pinout standard. A
standard was created to aid compatibility between LaunchPad development kits and BoosterPack plug-in
modules across the TI ecosystem.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/lit/pdf/SLAU445
http://www.ti.com/lit/pdf/SLAU278
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While most BoosterPack plug-in modules are compliant with the standard, some are not. The MSP-
EXP430FR2355 LaunchPad development kit is compatible with all 40-pin BoosterPack plug-in modules
that are compliant with the standard. If the reseller or owner of the BoosterPack plug-in module does not
explicitly indicate compatibility with the MSP-EXP430FR2355 LaunchPad development kit, compare the
schematic of the candidate BoosterPack plug-in module with the LaunchPad development kit to ensure
compatibility. Keep in mind that sometimes conflicts can be resolved by changing the MSP430FR2355
device pin function configuration in software.

Figure 9. BoosterPack Checker Tool

To check the compatibility of a BoosterPack plug-in module with the LaunchPad development kit of your
choice, use the BoosterPack Checker tool. This allows you to select any LaunchPad development kit we
offer and determine its compatibility with any number of BoosterPack plug-in modules that we offer. You
can also add your own BoosterPack plug-in module to check its compatibility as you prototype that next
design.

Figure 10 shows the 40-pin pinout of the MSP430FR2355 LaunchPad development kit.

Note that software's configuration of the pin functions plays a role in compatibility. The LaunchPad
development kit side of the dashed line shows only the applicable function for conforming to the standard.
However, each pin has other functionality that can be configured by the software. See the
MSP430FR2355 device data sheet for more details on individual pin functions.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
https://dev.ti.com/bpchecker/#/
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Figure 10. LaunchPad Development Kit to BoosterPack Plug-in Module Connector Pinout

2.8 Design Files

2.8.1 Hardware
Schematics can be found in Section 6. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available on the MSP-EXP430FR2355 Design File download
page.

2.8.2 Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available on the MSP-EXP430FR2355 Design File download page.

2.9 Hardware Change Log
Table 3 lists the hardware revision history.

Table 3. Hardware Change Log

PCB Revision Description
Rev A Initial release

3 Software Examples
Two software examples are included with the MSP430FR2355 LaunchPad development kit (see Table 4),
which can be found in the MSP430FR2355 LaunchPad development kit download page and are also
available inside MSPWare.

Table 4. Software Examples

Demo Name
BoosterPack

Plug-in Module
Required

Description More Details

OutofBox_MSP-EXP430FR2355 None
The out-of-box demo preprogrammed on the
LaunchPad development kit from the factory.
Demonstrates features of MSP430FR2355 device

Section 3.1

BlinkLED_MSP-EXP430FR2355 None Blinks an LED on the LaunchPad development kit at a
fixed interval Section 3.2

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/lit/zip/slar152
http://www.ti.com/lit/zip/slar152
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR2433/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR2433/latest/index_FDS.html
http://www.ti.com/tool/msp430ware
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To use any of the software examples with the LaunchPad development kit, you must have an integrated
development environment (IDE) that supports the MSP430FR2355 device (see Table 5).

Table 5. IDE Minimum Requirements for MSP-EXP430FR2355

Code Composer Studio IDE IAR Embedded Workbench for Texas
Instruments MSP430 IDE

v8.0 or later v7.12.1 or later

For more details on how to get started quickly and where to download the latest CCS and IAR IDEs, see
Section 4.

3.1 Out-of-Box Software Example
This section describes the functionality and structure of the Out-of-Box software that is preloaded in the
EVM.

The Out-of-Box Experience (OOBE) of the MSP-EXP430FR2355 LaunchPad development kit
demonstrates how to set up the integrated SAC and use it to condition an analog output so that it can be
properly sampled by the ADC converter on the MCU.

3.1.1 Source File Structure
The project is split into multiple files (see Table 6). This makes it easier to navigate and reuse parts of it
for other projects.

Table 6. Source File and Folders

Name Description
main.c Out-of-Box demo main function
lightsensor.c Contains functions for the Light Sensor mode
functiongenerator.c Contains functions for the Function Generator mode
Library: driverlib Device driver library
Library: jsmn Minimalistic third-party library for parsing JSON formatted strings

3.1.2 Overview
Upon powering up the Out-of-Box demo, the board enters the Light Sensor mode where LED1 or LED2
brightens/dims based on the intensity of the ambient light hitting the on-board photodiode. By pressing
button S2, the board enters the Function Generator mode where an input signal (sourced internally or
externally) is fed into a SAC configured in PGA mode, and the final output waveform is captured with the
internal ADC. At any time, press S2 to switch between the Light Sensor mode and Function Generator
mode.

When the demo is in Function Generator mode, an online cloud GUI (MSP-EXP430FR2355 OOB GUI)
can be used with the development kit to control the input signal source and visualize the real-time ADC
measurement. In addition to S2, the GUI provides buttons that can also be used to switch between
modes.

NOTE: The MSP430FR2355 microcontroller is equipped with four on-chip Smart Analog Combos
(SAC), which come in pairs of two, SAC0 with SAC2 and SAC1 with SAC3. Each pair of
SACs is interconnected, where the output of one SAC can be fed into the input of its paired
SAC. The Out-of-Box demonstrates these interconnections and uses one SAC pair in the
Light Sensor mode and the second SAC pair in the Function Generator mode.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
https://dev.ti.com/gallery/view/3491167/MSP-EXP430FR2355_OOB_GUI/
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3.1.3 Light Sensor Mode
The Light Sensor mode uses the SAC0 and SAC2 pair, two Timer_B modules, and the ADC of the
MSP430FR2355 MCU, combined with the on-board photodiode and LEDs of the LaunchPad development
kit, to implement a simple light sensing application. It configures SAC2 as a generic op-amp and, together
with R3 and C6, implements a transimpedance amplifier to convert the photodiode current to a voltage. To
measure this voltage with the device’s ADC, the output voltage of SAC2 is then fed through SAC0
(configured as a buffer), whose output is connected internally to the ADC.

When the Out-of-Box demo is first programmed onto the LaunchPad development kit, a default ADC
threshold is set to approximately half of the full brightness detection range of D1. If the ADC measurement
is below this brightness threshold, the red LED1 illuminates, and if the ADC measurement is above the
default threshold, the green LED2 illuminates corresponding to the intensity of the ambient light. To
recalibrate the threshold to the ADC value measured from the ambient light, press S1. The user can
influence the amount of light reaching the photodiode by using a flashlight or covering the photodiode
observing the changes in the LED brightness.

3.1.4 Function Generator Mode
In the Function Generator mode, an input signal (sourced internally or externally) is fed into the SAC1
configured in the Programmable Gain Amplifier (PGA) mode to be manipulated and captured with the
internal ADC. The LaunchPad kit repeatedly measures and transfers this data to the PC through UART.
When the Out-of-Box demo is first programmed onto the LaunchPad development kit, the Function
Generator mode is initially configured to generate a 1-Hz sine wave at 0.8-V amplitude using the SAC3
DAC, and the sine wave is fed into SAC1 configured in the inverting PGA mode with a gain of 1. When
visualized in the OOB GUI, you should see an inverted sine wave as shown in Figure 11.

Figure 11. Default Waveform of the Function Generator Mode

Using the GUI, the input signal source can be selected between the internal 12-bit DAC (SAC3) and an
external signal source. When the “Internal DAC” is selected as the input signal source, the GUI can be
used to generate different types of signals (sinusoidal, square, or sawtooth) of various frequencies and
amplitudes. The SAC1 PGA inverting or noninverting gain can be used to manipulate the generated signal
of the SAC3 DAC, and the output waveform is captured with the internal ADC connection and displayed
on the cloud GUI.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
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NOTE: When SAC1 is configured in the Inverting PGA mode, the SAC3 DAC generates sine,
square, or sawtooth waveforms with a DC bias of +1.65 V, and the SAC1 DAC is used to
generate a +1.65-V DC bias for the SAC1 PGA.

When SAC1 is configured in the Noninverting PGA mode, the SAC1 DAC is not available to
generate a DC bias for its PGA and is based to 0 V by default. Therefore, the SAC3 DAC
generates sine, square, or sawtooth waveforms with minimum peaks at 0 V.

Alternatively, an external signal source can be directly fed into the inverting input of the SAC1 PGA by
selecting "P1.6 OA1- Inverting PGA IN" or the noninverting input of the SAC1 PGA by selecting "P1.7
OA1+ Non-inverting PGA IN" as the input signal source using the GUI. In these two input signal source
configurations, the SAC1 PGA inverting or noninverting gain can be used to manipulate the external input
signal on P1.6 or P1.7, and the output waveform is captured with the internal ADC connection and
displayed on the cloud GUI.

Finally, SAC3 and SAC1 can be completely bypassed by selecting "P1.5 ADC Direct IN" as the input
signal source. In this case, an external signal can be connected to P1.5 and measured directly by the
internal ADC of the MCU, acting as a primitive oscilloscope.

3.2 Blink LED Example
This simple software example shows how to software toggle a GPIO to blink an LED on the LaunchPad
development kit.

3.2.1 Source File Structure
The project is split into multiple files (see Table 7). This makes it easier to navigate and reuse parts of it
for other projects.

Table 7. Source File and Folders

Name Description
main.c The Blink LED main function
Library: Driverlib Device driver library

The main code uses the MSP430 Driver Library to halt the watchdog timer and to configure and toggle the
P1.0 GPIO pin connected to the LED inside a software loop.

4 Resources

4.1 Integrated Development Environments
Although the source files can be viewed with any text editor, more can be done with the projects if they’re
opened with a development environment like Code Composer Studio IDE (CCS) or IAR Embedded
Workbench IDE.

4.1.1 TI Cloud Development Tools
TI’s Cloud-based software development tools provide instant access to MSPWare content and a web-
based IDE.

4.1.1.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries and documentation
found in MSPWare without having to download files to your local drive.

Go check out TI Resource Explorer Cloud now at dev.ti.com.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://www.ti.com/tool/msp430driverlib
http://www.ti.com/ww/en/launchpad/software.html
http://dev.ti.com/
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Figure 12. TI Resource Explorer Cloud

4.1.1.2 Code Composer Studio Cloud
Code Composer Studio Cloud (CCS Cloud) is a web-based IDE that enables you to quickly create, edit,
build and debug applications for your LaunchPad development kit. No need to download and install large
software packages, simply connect your LaunchPad development kit and begin. You can choose to select
from a large variety of examples in MSPWare software and Energia or develop your own application. CCS
Cloud supports debug features such as execution control, breakpoints and viewing variables.

For more information, see the full comparison between CCS Cloud and CCS Desktop.

Go check out Code Composer Studio Cloud now at dev.ti.com.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
https://dev.ti.com/about#cloudordesktop
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Figure 13. CCS Cloud

4.1.2 Code Composer Studio IDE
Code Composer Studio Desktop is a professional integrated development environment that supports TI's
Microcontroller and Embedded Processors portfolio. Code Composer Studio comprises a suite of tools
used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source code
editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS and download it at http://www.ti.com/tool/ccstudio.

CCS v8.0 or higher is required. When CCS has been launched, and a workspace directory chosen, use
Project>Import Existing CCS Eclipse Project. Direct it to the desired demo project directory that contains
main.c.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
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Figure 14. Directing the Project>Import Function to the Demo Project

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, CCS should recognize the project and allow you to import it. The indication that CCS
has found it is that the project appears in the box shown in Figure 15, and it has a checkmark to the left of
it.

Figure 15. When CCS Has Found the Project

Sometimes CCS finds the project but does not show a checkmark; this might mean that your workspace
already has a project by that name. You can resolve this by renaming or deleting that project. (Even if you
do not see it in the CCS workspace, be sure to check the workspace directory on the file system.)

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
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4.1.3 IAR Embedded Workbench for Texas Instruments 430 IDE
IAR Embedded Workbench for MSP430 is another very powerful integrated development environment that
allows you to develop and manage complete embedded application projects. It integrates the IAR C/C++
Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build utility, and IAR
C-SPY® Debugger.

Learn more about IAR Embedded Workbench for MSP430 and download it at
http://supp.iar.com/Download/SW/?item=EW430-EVAL.

IAR v7.12.1 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSPWare, which contains MSP430 libraries and the TI Resource Explorer. These are already
included in a CCS installation (unless the user selected otherwise).

4.2 LaunchPad Development Kit Websites
More information about the LaunchPad development kit, supported BoosterPack plug-in modules, and
available resources can be found at:
• MSP-EXP430FR2355 tool folder: resources specific to this particular LaunchPad development kit
• TI’s LaunchPad development kit portal: information about all LaunchPad development kits from TI

4.3 MSPWare and TI Resource Explorer
TI Resource Explorer is a tool integrated into CCS that allows you to browse through available design
resources. TI Resource Explorer will help you quickly find what you need inside packages including
MSPWare, ControlSuite, TivaWare and more. TI Resource Explorer is well organized to find everything
that you need quickly, and you can import software projects into your workspace in one click!

TI Resource Explorer Cloud is one of the TI Cloud Development tools, and is tightly integrated with CCS
Cloud. See Section 4.1.1 for more information.

MSPWare is a collection of code examples, software libraries, data sheets and other design resources for
ALL MSP devices delivered in a convenient package – essentially everything developers need to become
MSP experts!

In addition to providing a complete collection of existing MSP design resources, MSPWare also includes a
high level API called MSP Driver Library. This library makes it easy to talk to MSP hardware. More
information can be found at http://www.ti.com/tool/mspware.

Figure 16. Using TI Resource Explorer to Browse MSP-EXP430FR2355 in MSPWare

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://supp.iar.com/Download/SW/?item=EW430-EVAL
http://www.ti.com/tool/msp-exp430fr2433
http://www.ti.com/launchpad
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Inside TI Resource Explorer, these examples and many more can be found, and easily imported into CCS
with one click.

4.4 FRAM Utilities
The Texas Instruments FRAM Utilities is a collection of embedded software utilities that leverage the ultra-
low-power and virtually unlimited write endurance of FRAM. The utilities are available for MSP430FRxx
FRAM microcontrollers and provide example code to help start application development.

4.4.1 Compute Through Power Loss
Compute Through Power Loss is a utility API set that enables ease of use with LPMx.5 low-power modes
and a powerful shutdown mode that allows an application to save and restore critical system components
when a power loss is detected.

4.4.2 Nonvolatile Storage (NVS)
The nonvolatile storage (NVS) library makes handling of nonvolatile data easy and robust against
intermittent power loss or asynchronous device resets. To keep data storage constant, the nonvolatile
storage library contains functions that store data in a way that is guaranteed to recover the last valid entry
without data corruption.

4.5 MSP430FR2355 MCU

4.5.1 Device Documentation
At some point, you will probably want more information about the MSP430FR2355 device. For every MSP
device, the documentation is organized as shown in Table 8.

Table 8. How MSP Device Documentation is Organized

Document For MSP430FR2355 Description
Device family
user’s guide

MSP430FR4xx and MSP430FR2xx Family
User's Guide

Architectural information about the device, including all modules
and peripherals such as clocks, timers, ADC, and so on

Device-specific
data sheet

MSP430FR2355 Mixed-Signal
Microcontroller data sheet

Device-specific information and all parametric information for this
device

4.5.2 MSP430FR2355 Code Examples
MSP430FR243x, MSP430FR253x, MSP430FR263x Code Examples is a set of simple C examples that
demonstrate how to use the entire set of peripherals on the MSP430FR2533 MCU, including serial
communication, ADC10, Timer, and others, through direct register access. Every MSP derivative has a set
of these code examples. When starting a new project or adding a new peripheral, these examples serve
as a great starting point.

4.5.3 MSP430 Application Notes and TI Designs
Many application notes can be found at www.ti.com/msp430. Also see TI Designs for practical design
examples and topics.

4.6 Community Resources

4.6.1 TI E2E™ Community
Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community!

4.6.2 Community at Large
Many online communities focus on the LaunchPad development kit – for example, www.43oh.com. You
can find additional tools, resources, and support from these communities.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU680
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/FRAM_Utilities/latest/exports/FRAM-Utilities-UsersGuide.pdf
http://www.ti.com/fram
http://www.ti.com/fram
http://www.ti.com/lit/pdf/slau445
http://www.ti.com/lit/pdf/slau445
http://www.ti.com/lit/pdf/SLASEC4
http://www.ti.com/lit/pdf/SLASEC4
http://www.ti.com/lit/zip/slac700
http://www.ti.com/msp430
http://www.ti.com/general/docs/refdesignsearch.tsp
http://e2e.ti.com/
http://www.43oh.com/
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5 FAQ
Q: I can’t get the backchannel UART to connect. What’s wrong?
A: Check the following:
• Do the baud rate in the host terminal application and the eUSCI settings match?
• Are the appropriate jumpers in place, on the isolation jumper block?
• Probe on RXD and send data from the host. If you don’t see data, it might be a problem on the host

side.
• Probe on TXD while sending data from the MSP. If you don’t see data, it might be a configuration

problem with the eUSCI module.
• Consider the use of the hardware flow control lines (especially for higher baud rates).

Q: The MSP430G2 LaunchPad development kit had a socket, allowing me change the target device.
Why doesn’t this LaunchPad development kit use one?
A: The target device on this LaunchPad development kit does not come in the dual in-line package.
Sockets for the available device package are too expensive for this kit’s target price.

http://www.ti.com
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6 Schematics

Figure 17. Schematics (1 of 2)
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Figure 18. Schematics (2 of 2)
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